
Microsoft Word 2003 

Lesson 7: Viewing and Printing 

Objectives: 
By the end of this section you will be able to: 

 Use different views 

 View multiple documents 

 Preview documents 

 Print documents 



Viewing Your Document 

This section concentrates on the different ways a Word document can be viewed. 

Word provides several different ways a document can be viewed on screen.  The view 
that you choose depends on the type of document that you are creating, and whether 
speedy performance or exact layout is important to you. 

You can switch between different views using the view buttons at the bottom left corner 
of your screen (seen below) or by choosing View from the menu bar and then selecting  

the appropriate view from the list. 
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 Figure 7 - View selector buttons 

 

Normal View 

This view shows the document being viewed or edited as a scrolling list.  Page breaks are 
represented as dotted lines across the screen.  Normal view doesn’t display graphics or 
inserted objects but it is the quickest view for editing and review purposes as it uses less 
memory.  It is therefore a good view to use when working on long documents. 

 To switch to Normal View: 
Mouse 
• Click on the first view selector button (Normal view).  

Or 
Menu 
• Choose View from the menu bar and click the Normal option. 



Print Layout View 

Page Layout View shows the current document exactly as it will be printed out on paper.  
This is very useful for reviewing the layout of a document and checking if the “white 
spaces” (i.e. margins, blank lines) look right.  Graphics can be seen in Page Layout view 
so therefore it is a good view to use when inserting pictures and diagrams.  However, 
there is a performance overhead – it uses more memory than Normal view and so with 
large documents, Word may take longer to update changes. 

 

 To switch to Print Layout View: 
Mouse 
• Click the third view selector button (Print Layout). 

Or 
Menu 
• Choose View from the menu bar and click the Page Layout option 

Web Layout View 

Web Layout View shows your document as it would look if you published it to the Web 
or an intranet. In this view, you can see backgrounds, AutoShapes, and other effects that 
are commonly used in Web documents or documents that you view on the screen.  

 To switch to Web layout view: 
Mouse 
• Click on the second view selector button (Web Layout).   

Or 
Menu 
• Choose View from the menu bar and click the Web Layout option 

Outline View 

In Outline View, Microsoft Word simplifies the text formatting to help you focus on the 
structure of your document. Outline view looks very different from other views.  The text 
appears with symbols down the left-hand edge and an extra toolbar is displayed. 

Word indents each heading according to its level. The indentations appear only in outline 
view; Word removes the indentations when you switch to another view. 



When reorganising long documents, outline view gives the user tools for quickly 
repositioning large blocks of text and promoting and demoting heading levels where 
appropriate.  You can also view a document fully expanded, showing headings and their 
detail text, or collapsed (headings only). 

The structure of the document seen in Outline View is controlled by heading styles used 
in the document. The use of heading styles is covered in later Word courses and is 
therefore not dealt with in this manual. 

 To switch to Outline view: 
Mouse 
• Click the fourth View Selector button.  

Or 
Menu 
• Choose View from the menu bar and choose the Outline option. 

 Figure 8 - Outline View 
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Document Map 

The Document Map is a separate pane that displays a list of headings in the document. 
Use the Document Map to quickly navigate through the document and keep track of your 
location in it. When you click a heading in the Document Map, Word jumps to the 
corresponding heading in the document, displays it at the top of the window, and 
highlights the heading in the Document Map. You can show or hide the Document Map 
at any time.  

 

 To switch to the Document Map: 
Menu 
• Click Document Map on the View menu. 

Or 
Mouse 

• Click  

 

 



Viewing multiple documents 

In Word, you can view all open documents on the screen at the same time by arranging 
them top to bottom on the screen. 

 

 To view more than one document: 
Menu 
• If the Microsoft Word documents you want to arrange are 

minimized, restore the minimized documents first. 

• On the Window menu, click Arrange All. 

 
Note: To revert back to one document view again on full screen, simply 
maximise one of the windows. 

 Figure 9 - Arranged documents 



Printing 

The open document can be printed in its entirety, or alternatively you can print individual 
pages or ranges of pages. Word gives you the ability to choose which pages you want to 
print, or if you need to be even more specific, you can print only the selected items. 

Before sending any document through to the printer, it is always a good idea to preview 
what the hard copy will look like so that you can rectify any problems before printing it. 

Print Preview 

This is another way that you can view your document.  When you are in print preview, 
Word gives you a special toolbar for changing the number of pages per screen, zooming 
in and out and so on.  If you spot mistakes as you are previewing a document, you can 
even edit in print preview. 

 

 To access print preview:  
Mouse 

• Click the Print Preview  button from the standard toolbar. 

 

 Figure 50 - Print preview screen 



 

• Click the Next page or Previous page buttons to scroll backwards 
and forwards through your document’s pages. 

Or 
Keyboard 
• Press [PAGE UP] or [PAGE DOWN]. 

The Print preview toolbar 
The print preview toolbar only appears when you are in Print preview.  It gives you 
useful tools for changing such things as magnification and how many pages you can see 
on one screen.  The button functions are described in detail below: 

 

 To close the Print Preview: 
Mouse 
• Click the button marked Close from the Print preview toolbar.  

OR 
Keyboard 
• Press [ESC] on the keyboard. 

Magnification 
When you are in Print preview, Word automatically changes your mouse pointer into a 
magnifying glass that you can use to zoom and out on particular areas of the currently 
displayed page.  

 To change magnification: 
Mouse 
• In the Print preview screen position your mouse over the area that 

you want to zoom in on and click. 

• To zoom out, click the mouse a second time. 

 To print the document: 
Mouse 
• From the Print preview toolbar click the print button.  You will 

see an icon appear on the status bar showing a working printer 
indicating that your file is being dispatched to the printer. 



Edit from the Print preview screen 
Print preview is generally used to view how the document will look when it is printed.  
However, because you may spot mistakes that you want to correct as you are viewing the 
document Word has built in the ability to edit from within the Print preview. 

 To edit a document in Print preview: 
Mouse 
• In the Print preview window, move to the page that you want to 

edit. 

• Click the Magnifier button from the toolbar.  This will change 
your mouse pointer from a magnifying glass into an “I” beam. 

• Click the “I” beam to anchor the cursor where you want to make 
the changes. 

• When you have finished editing, switch the Magnifier back on by 
clicking the button once again. 

Pages per screen 
You can preview your document page by page in the Print preview screen or you can see 
several pages at once. 

 Change the number of pages viewed: 
Mouse 
• From the Print preview screen, click the Multiple pages button.  

• Drag your mouse over the grid to select the number of pages you 
want to see.  When you release the mouse, your Print Preview 
screen will change to reflect your choice. 

Or 
• Click the One page button to show only a single page in the Print 

preview. 



Zoom 
Word will automatically scale your document to fit in the preview screen depending on 
how many pages you selected to view.  You can change the scale with the Zoom drop 
down list which offers you different percentages.  Choosing Page Width would ensure 
that the width of the page fits in to the preview screen, whereas Whole page would fit 
both the width and the height.  Two pages would show consecutive pages side by side. 

 To change the Zoom: 
Mouse 
• From the Print preview screen, click the drop down 

list arrow to the right of the current zoom percentage 
box. 

• Select the required option by clicking it.  Word will 
change the preview according to your choice. 

View ruler 
The ruler is useful if you are editing in the Print preview screen as it allows you to change 
the position of tabs and indent markers.  However, it does use up space so if you want to 
maximise the scale of the page within the preview window, you would have more room if 
you switched the ruler off. 

 To toggle the ruler on and off: 
Mouse 
• From the Print preview screen click the View ruler button to 

switch the ruler off. 

• Each time you click the button, the ruler will toggle on or off. 

Shrink to fit 
If only a small amount of text appears on the last page of a short document, you may be 
able to reduce the number of pages by clicking Shrink to Fit in print preview. This feature 
works best with documents that contain only a few pages, such as letters and memos. In 
order to shrink the document, Word decreases the font size of each font used in the 
document. 

 To shrink to fit: 
Mouse 
• From the print preview screen, click the Shrink to fit button.  



Note: You can undo a Shrink to Fit operation by clicking Undo Tools 
Shrink to Fit on the Edit menu. However, after you save the document and 
close it, there is no quick way to restore the original font size. 

Full screen 
As a space saving option, you can fill the whole screen with a preview of your document, 
without sacrificing space to title bars and menus. 

 

 To preview full screen: 
Mouse 
• From the Print preview screen, click the Full screen button.   The 

title bar, menu bar and status bar will disappear to display a 
window like the one shown overleaf: 

 

• Click the Close Full Screen button when you want to return to the 
normal screen. 



Print a document 
You can print a document directly from whatever view you are using.  Word will send 
the document to your default printer. 

 To print a document: 
Mouse 
• Click the print button from the standard toolbar 

Or 
Keyboard 
• Press [CTRL][P].  The Print dialog will appear; press [ENTER] to 

confirm the settings and launch the print.  Word will display the 
document printing icon on the status bar. 

 

Print part of a document 
The print button from the toolbar will always send one copy of the whole of the current 
document to the printer.  You may only need to print pages 1 and 2, or you may want to 
be even more specific and print just one paragraph.  To do any of these, you need to 
access the Print dialog. 

 To print a specific page or range of pages: 
Mouse 
• Choose File from the menu bar and then Print.   

Or 
Keyboard 
• Press [CTRL][P]. 

• The following dialog box will appear: 



  

 Figure 51 - Print dialog 

• In the Page Range section of the dialog, click the Pages 
option button.  A cursor will appear in the text box to the right. 

• Type in the page number that you want to print, or tell Word the 
range of pages (e.g. 1-6).  If your pages are not consecutive, you 
can enter them separated by commas (e.g. 1,10,13). 

• Click the OK button to launch the print. 

To print the current page:  
Mouse 
• Position the cursor somewhere on the page you want to print. 

 

• Choose File, Print to access the Print dialog. 

• Click the Current Page option button in the Page Range 
section of the dialog. 



• Click OK to launch the print. 

 To print the selection: 
Mouse 
• Select the text you want to print. 

• Choose File, Print to access the Print dialog. 

• Click the Selection option button in the Page Range section 
of the dialog. 

• Click OK to launch the print. 

Copies 
By default, Word will print one copy of the item you have sent to print.  You can print 
multiple copies by changing the Print dialog settings.  When you print multiple copies of 
a document, Word lets you choose whether the copies are collated (Word prints each 
whole document before it starts on the next copy) or uncollated (Word prints however 
many copies you have requested of each page). 

 

 To print multiple copies: 
Mouse 
• Choose File, Print to access the Print dialog.  

 

• In the Copies section of the dialog, use the up and down arrows 
to the right of the Number of copies text box to set the number 
of copies you require. 

• Set the Collate check box by clicking in it to change the current 
setting. 

• Click OK to launch the print. 



Cancel a print 
If you accidentally send something to print and need to cancel it, you can do so by 
double-clicking on the document printing icon that appears on the status bar. 

Document printing 
icon 
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